
( 

( 

( 

( StyleWare DeskWorks™ 



DeskWorks by 
Jeff Erickson, Kevin Harvey, 
Mike Hibbetts, Tom Hoke, 
Scott Holdaway, Scott Lindsey, 
Ian Mitchell, Syd Polk 

DeskWorks User's Manual 
by Pat Dames and Gail Drago 

© 1987,1988 StyleWare, Inc. 
All rights reserved worldwide. 
No part of this publication may be repro
duced, transmitted, transcribed, stored in a 
retrieval system, or translated into any 
human or computer language, in any form or 
by any means, without the express written 
permission of StyleWare, Inc. 

StyleWare, Inc. makes no warranty or 
representation, either express or implied, 
with respect to the enclosed software, its 
quality, performance, merchantability, or 
fitness for any particular purpose. As a 
result, this software is sold "as is," and you, 
the purchaser, are assuming the entire risk as 
to its quality and performance. Furthermore, 
StyleWare, Inc. reserves the right to revise 
this publication and to make periodic 
changes in the content hereof without 
obligation of StyleWare, Inc. to notify any 
person or organization of such revision or 
changes. 

TopDraw, MultiScribe, MultiScribe GS, and 
the StyleWare logo are trademarks of Style
Ware, Inc. 

PaintWorks Plus is a trademark of Activ
ision, Inc. 

Apple and the Apple logo are registered 
trademarks of Apple Computer, Inc. Apple 
IIGS is a trademark of Apple Computer, Inc. 

Apple Computer, Inc. makes no warran
ties, either express or implied, regarding 
the enclosed computer software package, 
its merchantability or its fitness for any 
particular purpose. The exclusion of 
implied warranties is not permitted by 
some states. The above exclusion may not , 
apply to you. This warranty provides you 
with specific legal rights. There may be 
other rights that you may have which 
vary from state to state. 

ProDOS is a copyrighted program of Apple , 
Computer, Inc. licensed to StyleWare, Inc. 
to distribute for use only in combination 
with DeskWorks. Apple Software shall not' 
be copied onto another diskette (except for 
archive purposes) or into memory unless as 
part of the execution of Desk Works. When I 

DeskWorks has completed execution Apple 
Software shall not be used by any other 
program. 

( 

( 

C 

c 
c 
(' 

( 

( 



( 

Con ten t s: DeskWorks User's Manual 

11 About DeskWorks 
III Contents 
iv About This Manual 

2 Chapter 1: Getting Started 
2 Contents 
3 Introduction/Before You Begin 
7 Installing DeskWorks 
7 Installing DeskWorks Using Two 3.5 Inch Drives or a Hard Drive 

11 Installing DeskWorks on a One Drive System Using a Finder 
16 Removing Desk Accessories. 
17 Using Desk Works with an Application 

19 Chapter 2: DeskWorks Accessories 
20 Contents 
23 Introduction 
23 Calendar/Appointment Book 
29 The Scrapbook 
35 The PhoneFiler 
40 Keymac 
48 Screen Saver 
50 NotePad 
53 Calculator 
61 Mr. Apple 
61 The Alarm Clock 
63 The Menu Clock 
64 The System Clock 
64 Enigma 

67 Chapter 3: Practical Uses for DeskWorks 
68 Contents 
69 Introduction 
69 Sample Applications 

79 Chapter 4: Reference Chapter 
80 Contents 
81 DeskWorks Original Defaults and Disk Capacity 
82 Special Files and Folders 
84 Glossary 
87 Index 

• 



------ ---- -

About This Manual 

DeskWorks User's Manual explains how to install and incorporate 
DeskWorks into your favorite Apple lIGS programs. It will also show 
you how to best utilize the functions of each desk accessory. 

Chapter l,"Getting Started," describes the hardware needed to start up the 
program, teaches you how to create a backup disk, and explains the 
Finder. In addition, you'll learn how to install DeskWorks with step-by
step instructions that show you how to use desk accessories with other 
Apple IIGS-specific application programs. 

Chapter 2, "Using DeskWorks," displays the screen appearance of each 
accessory, explains its functions, and details the steps you must take to 
use it. 

Chapter 3, " Practical Uses for DeskWorks," provides useful examples of 
how DeskWorks can be used to organize and automate everyday tasks. 

Chapter 4, "Reference," gives you important technical information 
concerning disk capacity, file location and the default setting of each desk 
accessory. A glossary of terms and an index are also included at the back 
of the reference chapter. 
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Getting Started 
Chapter I, "Getting Started," introduces you to the twelve DeskWorks 
desk accessories and explains their functions. In this chapter, you'll also 
learn what is required to begin using them. 

The first section, "Before You Begin," explains the Finder and suggests 
reading materials that will acquaint you with efficient ways to organize 
files and folders. In the process, you'll refresh your memory regarding 
Clipboard operations. This important explanation is followed by "What 
You Need to Get Started," which contains information about hardware 
needed to run the program. 

And, to insure that you'll always have DeskWorks in your disk library, 
"What You Need to Make A Copy of DeskWorks" will acquaint you with 
utility programs used to make backups. The procedure you'll need to 
follow in order to copy the program is outlined in the section entitled, 
"Creating Backups Using the Finder." Then, at the end of the chapter, 
you'll learn installation procedures that should be followed for your 
particular hardware setup in "Installing DeskWorks." 

--------.---~ --

Before You Begin 

The instructions contained on the next few pages will guide you through 
such procedures as making a backup copy of the DeskWorks disk and 
installing the desk accessories using the Finder. 

The DeskWorks disk comes complete with the Finder, a system software 
program that provides you with a desktop from which you can run the 
DeskWorks accessories as well as application programs. By using icons, 
this utility program gives a graphic representation of the Apple IIGS 
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desktop as well as the hardware and software used by your machine. 

Now would be a good time to review your Apple lIeS Owner's Guide for 
information regarding organization of files, Clipboard operations (Cut, 
Copy, and Paste), duplication, and backup procedures. 

What You Need to Get Started 

To use DeskWorks, you'll need the following equipment: 

• an Apple IIGS with a Memory Expansion Card with at least 5l2K 

(768K is recommended 

• a monitor (RGB or composite color is preferable) 

• a 3.5-inch disk drive 

What You Need to Make A Copy of DeskWorks 

You should make two copies of the DeskWorks program disk. This is a 
precaution against your disk being destroyed by such unexpected mishaps as 
the natural elements, computer malfunction, spilled coffee, or perhaps an ill
disciplined puppy eager to taste the world of computer technology. 

To make these backups, use one of the following utility programs: 

• The Finder that came on your DeskWorks disk 

• The Copy Files command or Duplicate a Disk command on the Apple II 

System Utilities Disk 

• The COPY command in the Copy II Plus Utilities published by Central 

Point Software, Inc. 
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Creating Backups Using the Finder 

You can use the Finder on your DeskWorks disk to make a backup disk. 

• Start up your Apple IIGS with the DeskWorks disk in the disk drive. 
The icon will appear on your Finder desktop, labeled StyleWare.DW. 

• If you're using a two disk drive system, insert a blank disk in your 

second drive. 

• If you're using a single disk drive system, eject the DeskWorks disk 

and insert a blank disk. 

Should you use an uninitialized disk, you'll see the message, "This 
disk is unreadable. Do you want to initialize it as a ProDOS disk?" 
Select "Initialize" and press the return key. You will then be asked to 
name the disk. Type "DeskWorks" in the highlighted field and press 

• 
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return or click the OK button. After the disk is initialized, it will appear 
as an icon on the Finder desktop. 

• Drag the DeskWorks disk icon to the new disk icon, and release the 

mouse button. You '11 see a dialog box asking, "Completely replace the 
contents of Desk Works with the contents of Style Ware.DW?" 

File Edit Vi~ 



If you're using a single drive, the Finder will tell you when to exchange 
disks. Follow the instructions on the screen to complete the operation. 

When you've completed your two backups, store the program disk and 
one of the backups in a safe place. Use the remaining backup for 
installing DeskWorks in your application programs. DeskWorks will 
work with any IIGS-specific software created according to Apple systems 
software standards. 

Installing DeskWorks 

You're ready to install the accessories on your application programs. 
MultiScribe GS is used in the following procedures to illustrate how to 
install DeskWorks in an application. In the following procedures the 
MultiScribe GS disk is titled StyleWare3. Choose one of the following: 

Installing DeskWorks using a Two 3.S-lnch Drive System or 
on a Hard Drive Using the Finder: 

• Insert the DeskWorks disk in drive 1 and turn on your Apple IIGS. 

• Insert your application disk in drive 2. 

• Double-click the application disk icon or the hard drive icon on the 

Finder Screen. 

• Open the DeskWorks disk icon on the Finder screen by double

clicking it. 

• Double-click the System folder icon on the DeskWorks disk to open 

it. 
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Almost all of the DeskWorks accessories are located on the DeskWorks 
disk in the folder labeled Desk.Accs. The exception is the Menu Clock 
which is located in the System. Setup folder. If you want to move all of 
the accessories to your application disk, you can copy the entire 
Desk.Accs folder into your application System folder, then copy the 
Menu Clock to the System. Setup folder. 

If you want to move only a few of the accessories to your application, 
you can install them one at a time. If you're installing DeskWorks on a 
3.5-inch disk, space limitations will determine how many of the accesso
ries you'Il be able to use at a time. If, however, you are installing 
DeskWorks on a hard drive, you probably won't encounter this problem. 
With a 512K machine, you 'II be limited in the number of accessory 
programs you can use with your applications at a given time. Therefore, 
it would be advisable to install the accessories one at a time to see how 
the application will perform. 

To install the entire folder using two drives or a hard drive: 

• Drag the Desk.Accs folder icon on the DeskWorks disk to the System 

Folder on your application disk. 
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A dialog box will appear on the screen: 

( Don't replac~ this it~l. ) 
( Reploc~ this item. ) 

( Don't replace any duplicate items. ) 

( R~place all duplicate items. ) 

( Cancel 

0 
LETTER 

If you have desk accessories installed on your disk that you want to keep, 
click once on the "Don't replace any duplicate items." button. 

• After the other accessory files have been copied, open the 

System.Setup folder on your DeskWorks disk, and move the Menu 
Clock accessory to the System.Setup folder on your application disk. 

To install individual accessories using two drives or a hard 
drive: 

• Open the DeskWorks Desk.Accs folder. 

• 
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• Open the System folder on your application disk or on your hard drive. 

o 
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• For each accessory you want to install, drag its icon from the 

Desk.Accs folder on the DeskWorks disk to the Desk.Accs folder in the 
System folder on the application disk. 

• To copy the Menu Clock, open the System. Setup folder in the System 

folder on the DeskWorks disk and move the Menu Clock to the 
System. Setup folder on your application disk or hard drive. 

Repeat these steps with each of the accessories you wish to install, and 
they'll be copied onto your application disk or hard drive. To install more 
than one desk accessory, hold down shift. click the desired number of desk 
accessories and drag to the Desk.Accs folder on the application disk. 

Installing DeskWorks on a One Drive System Using the Finder 

• Insert your copy of the Desk Works disk in your drive, and tum on your 

Apple IIGS. 

• Double-click the DeskWorks disk icon to open it. 
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• Double-click the System folder icon to open it. 

• Eject the DeskWorks disk from your drive and replace it with the 

application program disk on which you want to install DeskWorks 
accessories. 

• Double-click the application disk to open it. 

~ 
HULT I SCRI8£.GS 

Almost all of the DeskWorks accessories are located in the folder labeled 
Desk.Accs. The exception is the Menu Clock, which is located in the 
System.Setup folder. If you want to move all of the accessories to your 
application disk, you can copy the entire Desk.Accs folder into your 
application's System folder, then copy the Menu Clock to the 
System.Setup folder. 

If you want to move only a few of the accessories to your application, you 
can move them one at a time. If you're installing DeskWorks on a 3.5-
inch disk, space limitations will determine how many of the accessories 
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disk, space limitations will determine how many of the accessories you'll 
be able to use at a time. With a 5I2K machine, you'll be limited in the 
number of accessory programs you can use with your applications. 
Therefore, it would be advisable to install a few accessory programs one 
at a time to see how the application will perform. 

To install the entire folder in a one drive system: 

• Drag the Desk Works Desk.Accs folder to System folder on your 

application disk, in this example, MuItiScribe OS. When the System 
folder is highlighted, release the mouse button. 

A dialog box appears on the screen. 

( Don't replace this itt •. ) 
( Replace this itel. 1 
( Don't replace any duplicate items. ) 
( Replace 011 duplicote itl!mS. ) 

Concel 

• A dialog box will appear on the screen telling you that the folder 

Desk.Accs already exists and asking if you want to replace it. Click the 
"Replace this item" button. Doing this will save any accessories you 
have in your folder. 



• After the files have been copied, open the System. Setup folder on your 

DeskWorks disk and move the Menu Clock accessory to the 
System. Setup folder on your application disk. 

o 
ClIPBOARD 

To install individual accessories on a one drive system: 

• Open the DeskWorks Desk.Accs folder in the System folder. 

• Open the System folder on your application disk. 
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SCRRPBOOK CALENDAR 

DOD 
HR.APPLE SAYER ENIGMA 

o 0 0 
PHOHEJILER KEY HAC HOTEPAD 
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• For each accessory you want to install, drag its icon from the 

Desk.Accs folder on the DeskWorks disk to the Desk.Accs folder on 
the application disk. 

D 
CALENDAR 

o 0 
HR.APPLE SAYER 

o 
ENIGMA 

II 



• 

• To copy the Menu Clock, open the System. Setup folder in the System 

folder on the DeskWorks disk and move the Menu Clock to the 
System.Setup folder on your application disk. 

The Finder prompts you for the necessary disk changes to complete this 
operation. 

( Cancel 

CJ 
SYSTEW.SETUP 

~ 
Removing Desk Accessories 

Remove DeskWorks desk accessories by dragging them from their folders 
on your application program disks or hard drive to the Trash Can. 

• Start up your computer with your working copy of the DeskWorks disk. 

• Open the disk icon on the Finder desktop which contains your 

application with desk accessories installed on it. 

• Open the Desk.Accs folder (or the System. Setup folder) and drag the 

DeskWorks icons for the desk accessories you wish to remove to the 
Trash Can on your Finder desktop . 
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SDUMPCDA SAVER 

liN.:! = SAVER.DATA 
o 

EmMA 
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KEYHPC 

• Choose Empty Trash from the Special Menu. 

Using DeskWorks With an Application in The Finder 

If you have two 3.5-inch disk drives, you don't have to install DeskWorks 
desk accessories to use them with your application. 

• Insert the DeskWorks backup disk in drive 1 and turn on your Apple IIGS. 

• When the Finder desktop appears, insert the application you want to use 

in drive 2. In this example, MultiScribe GS is inserted. 

• When the application disk appears on the desktop, double-click it to open 

it and double-click the application you want to run. 

• 
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• The Program Launcher will appear on your screen with a list of the files 

on the application disk. 

• Double-click the application program to run it. 

When the application program opens, the DeskWorks desk accessories will 
be accessible from the" Menu. 

Using DeskWorks Installed in an Application 

• Insert the application on which you've installed DeskWorks in your disk 

drive. 

• Turn on your Apple I1GS. 

• When the Program Launcher appears on your screen, choose the 

application program you want to run by double-clicking it. 

• The program desktop will appear on the screen, and the desk accessories 

you've installed in that application will be accessible from the" Menu. 
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Chapter 2: DeskWorks Accessories 
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CHAPTER TWO ... ... ... 
DeskWorks Accessories 

DeskWorks will not only put you a step closer to this highly technical 
world of ours, but it will also sharpen your organizational skills. Once 
you've learned to use the twelve features, you'll be amazed at the time 
you'l1 save and will wonder what life was like without them. 

With the System and Menu Clock available, for instance, the accurate 
time is always present to keep you on schedule. And, if you have an 
important appointment to keep, the DeskWorks Alarm Clock can act as a 
reminder. Also included in the program is a Calculator that can compute 
figures in a flash, a feature you'll appreciate if you've ever needed to 
balance your checkbook in a hurry. 

Other accessories include the Notepad, where you can jot down ideas, a 
Calendar that seconds as an Appointment Book, and the Scrapbook where 
you can do on-the-spot "cut and paste." In addition, you'll save time with 
the program's PhoneFiler that doubles as an address file and automatic 
phone dialer. 

Since "all work and no play" is not good for anyone, DeskWorks includes 
Enigma, a brain-teasing game of elimination designed for a lone player, a 
good diversionary tactic when you need a break. 

This chapter explains each accessory and takes you step-by-step through 
procedures that give you the maximum use of everyone. 

Calendar/Appointment Book 

The StyleWare Calendar/Appointment Book is a 12 month calendar, 
complete with an Appointment Book containing a page for each day's 
appointments and activities. The Calendar window displays the current 
date, highlights other important days that must be remembered, and 
enables you to record and delete appointment entries. 
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Accessing the Calendar/Appointment Book 

The Menu displays all the DeskWorks accessories you've installed. To 
open the Calendar/Appointment Book, choose it from the" Menu. The 
Calendar opens in the document window. 

I : 

" T II 
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The Month scroll bar 
changes the month. 

The Last Year 

11 12 13 1_ 15 16 17 
or Next Year button 
move from year to year. 

18 19 2' 21 22 
25 26 21 21 29 

Current date 

23 2~ 

III!.I 31 

The Open button 
opens the Appointment 
Book. 

The Clear Old Entries button 
deletes all entries on 
Appointment Book. 

The Calendar appears with the current day, month, and year displayed in 
the window. The current day is highlighted. To open the Appointment 
Book, double-click any date in the Calendar. The Appointment Book 
appears over the Calendar window. To open any date, either double-click 
it, press return, or click the Open button . 
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OK button 
saves entries. 

The Appointment Book provides fields representing the hours of the day 
from eight A.M. through five P.M. with a field for an evening entry. 
Each field can be cut, copied, and pasted from applications into the 
Appointment Book or from the Appointment Book into application 
documents. 

Using the Calendar 

The DeskWorks Calendar can display dates from January 1, 1935, to 
December, 31, 2034. When you choose the Calendar from the" Menu, 
it appears on your screen displaying the current date-the month, day and 
year. This date, as well as those which have Appointment Book entries, 
are represented by bold characters. 

Changing the Calendar Date 

Though setting the date of the DeskWorks Calendar can be done several 
ways, the easiest method is to change the day by clicking the date you 
wish to change. The selected date will appear inverted with white 
numbers on a black background. To move backward or forward through 
the month, click any of the displayed days. 

• 
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To change the month, click the arrows of the Month scroll bar. To move 
ahead one month, click the right scroll arrow once. To move back a 
month, click the left arrow once. If you wish to move several months into 
the future or back into the past, click the left or right scroll arrow the 
appropriate number of times. 

To change the year, click the Last Year button once to move back one 
year, or click the Next Year button once to move forward one year. 

Shortcuts to Changing the Date 

Another way to change a calendar month is to click a white space 
preceding the first day or following the last day of the displayed month. 
Clicking before the first day of the month will result in the previous 
month appearing on the screen. Clicking after the last day of the month 
will result in the following month being displayed. 

To return to the current day, month, and year, click the button displaying 
the current day's date. 

Using the Appointment Book 

The Appointment Book feature of the DeskWorks Calendar allows you 
to schedule appointments for each hour of the day from 8 A.M. to 5 P.M. 
with an added entry for the evening. To record an entry in the Appoint
ment Book, select a date by clicking it and then clicking Open, or double
click the date. The Appointment Book page will appear over the Calen
dar. To create an entry, click at the beginning of a field and type. Press
ing the tab key will also move you from field to field. Pressing return 
will take you back to the Calendar. The field holds approximately 30 
characters. 

Cutting, Copying, and Pasting Text 

Clipboard operations can be performed on one field at a time in the 
Appointment Book. You can transfer text between some accessories as 
well as from an application to the Appointment Book and from the 
Appointment Book to an application document. The text transfer must be 
between the Calendar and word processing applications, however; you 

~ can't transfer text to graphics programs. 
~ 
~ 
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Select the text you wish to cut or copy. Press It-x to cut it or use the~
C to copy it onto the Clipboard, and then use the Open 0 -V to paste the 
text into a document. You can't choose the Edit Menu commands when 
the Appointment Book is open. 

Using the Clear Old Entries Command 

To maximize space on your disks, you can delete past Appointment Book 
entries with the Clear Old Entries command. This command deletes all 
Appointment Book entries prior to the current date. When you click the 
Clear Old Entries button, a dialog box will appear warning you that "You 
will lose old entries." 

You can either cancel the operation, or click the OK button to continue. 

!t2nlb 
I 

( Cancel )( OK 
lost Veor ) 

"ext Veor ) 

Opea ) 

M~I,>l!abtr 1, 1937 ) ( ~. Cleor Old £ntriti ) 

Leaving the Calendar 

If yoy decide to work on your document but don't want to close the 
Calendar, you can reduce it to an icon that can be moved anywhere on 
your desktop. To collapse the accessory, hold down the option key and 
click anywhere in the Calendar window. If you click the application 
window, it will move in front of the Calendar icon and will become the 
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active window. If you think you'll be referring frequently to the Calen
dar, you may want to resize the application window so that the Calendar 
icon is visible. To return the icon to its full size, double-click it. If your 
icon is hidden behind the document window and you don't want to resize 
it, choose Calendar once again from the" Menu. 

If, however, you want to work on your document but decide to leave the 
Calendar its full size on your desktop, you can click the application 
window to move it in front of the Calendar. 

To exit the Calendar, click its close box. If the Calendar is in its icon 
fonn, double-click to open and return it to its full size. It's necessary to 
close the desk accessory before you exit the application or turn off your 
Apple IIGS in order to save the Appointment Book entries. 
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The Scrapbook 

States name or 
number of 
scrap 

Get File button 
accesses a 
specific file. 

Through DeskWorks, you can cut and copy text and graphic scrap files 
from many of your favorite Apple IIGS applications-including 
MultiScribe GS™, TopDrawTM, and PaintWorks Plus™-into a common 
storage file called the Scrapbook. Once a text or graphic scrap file has 
been placed into the Scrapbook, it can be used again and again, both with 
the application originally used to create it and with other applications as 
well. 

Using the Scrapbook 

The first page of the Scrapbook gives you the company name and author 
of the accessory. Above this information, you'll find the total number of 
scrap files contained within the application, and to the left, you'll see the 
specific name assigned to the current scrap file. 

of 
scrap files 

Each Horn 0 thousand Roses brings. you SOH. Q in Scrapbook 
Yes but where leaves the Roses of Yesterday? 
And this first SWlllltr .onth thot brings the Rose. 
Shall ~ake J(IIshyd and Kaikobod away. 

- "or Kbayy_. Rubaiyot 

¢I 

I'.O!'I. : .•.. ~ 
~." .. " ...... ~ 

~ 
I¢ 

Select button 
selects scrap file. 

Click Select or press return to display the scrap file listings on the 
Scrapbook. A dialog box appears on your screen: 
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You'll see a list of scrap files in your Scrapbook. The vertical scroll bar 
to the right displays the names that you've given to the scrap files. If you 
choose not to name the scrap files, the Scrapbook will automatically 
number them for you. The Get File button enables you to access picture 
or text files located on other disks or storage devices that you might want 
to add to the Scrapbook. 

Creating Scrap Files 

You can create scrap files to store in the Scrapbook by using one of 
several methods. If you've installed DeskWorks into an application 
program, you can use the Edit Menu commands to cut or copy graphics 
and sections of text onto the system Clipboard. By opening the Scrap
book accessory and choosing the Paste command from the Edit Menu, 
you transfer the contents of the Clipboard into the Scrapbook, creating a 
scrap file. 

Another method for creating scrap files is to use the Get File button to 
access text or graphic files from disk drives, RAM cards or hard drives. 
Click the Get File button or press the esc key, and the Get File dialog box 
will appear on the screen . 
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You will be asked, "Put which scrap file on clipboard?" To search files on 
a disk located on another drive, click the Disk button. Choose a file by 
selecting it in the list and click the Open button, or double-click the file in 
the list. Click the Cancel button if you change your mind and decide not 
to open a file. When you click the Open button, the entire file you've 
opened will be placed on the Clipboard. To insert it into the Scrapbook, 
choose the Paste command from the Edit Menu. A dialog box will appear 
requesting that you name your selection. Type the name for the scrap file 
in the space provided, or if you wish not to name it, the system will assign 
it a number by way of default. 

The advantage of using the first method for creating scrap files is that you 
can cut or copy the portion of the file you want to paste in the Scrapbook. 
On the other hand, by using the Get File method, you'll paste the entire 
file into the Scrapbook even if you're only interested in a portion of the 
file. 

To clip part of a scrap file from the Scrapbook into an application, click 
just above and to the right or left of the section you wish to cut. Then drag 
and pull diagonally to include the entire area. This action will result in a 
dotted rectangle that grows as you pull. You'll use this clip rectangle to 
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cut or copy sections of graphics or text scrap files to the Clipboard. Once 
you've framed the desired information, choose the Copy command from 
the Edit Menu or press" -C. This copies the scrap file to the Clipboard. 

SCRAP.3 Totol scraps: 

( Get file ) ( Select ) 

ii! :1:: 

These sections become PICT format files, whether they are composed of 
text or graphics and can be moved or resized as any PICT file can. You 
can now paste this PICT section into a document. If you should use the 
Cut command instead of Copy, the portion you cut will be placed on the 
Clipboard ready to paste, but the scrap file from which it was cut will be 
deleted. 

The DeskWorks Scrapbook uses only graphics saved in PICT format and 
text files saved in ASCII format. When you create scrap files using one 
of the methods listed above, the Scrapbook automatically converts the 
scrap files to these formats as they are saved. 

---I 
For information on another method of creating scrap files, I' 

see Chapter 4, "Reference," under "Special Files and Folders." 
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To see a listing of all the scrap files currently in the Scrapbook, click the 
Select button or press return. The names of all of the scrap files in the 
Scrapbook will appear in a list box. To view a scrap file, select your 
choice by clicking twice. When you have opened a scrap file, move to 
the next scrap file in the scrapbook by pressing the right arrow on the 
scroll bar at the bottom of the screen or use the tab key. To move to the 
first scrap file in the Scrapbook, press the left scroll arrow or simultane-

ously press the and tab keys. 

Editing Scrap Files 

The internal scroll bars, not to be confused with the scroll bar located on 
the bottom of the window that controls the files, gives you the chance to 
view an illustration too large for the screen. To see the complete image a 
section at a time, click the arrows on the scroll bar or clicking the shaded 
portion of the scroll bar. Clicking the arrows moves the illustration in 
small increments, while clicking the shaded area of the scroll bar moves 
the illustration by greater amounts. The arrow keys are the keyboard 
equivalent to the scroll arrows and will accomplish the same task. This 
action only applies to graphic scrap files and becomes inactive when a 
text scrap is selected. 

Putting a Scrap File into a Document 

To use scrap files in a document, open the Scrapbook. Select a scrap file 
from the Scrapbook and cut or copy it onto the Clipboard. Close the 
Scrapbook and position the insertion point in the document where you want 
to paste the text or graphic image. Choose the Paste command from the 
Edit Menu, and the scrap file will be pasted into your document. 

Deleting a Scrap File 

To erase a scrap file altogether, press the delete key or select Clear or Cut 
from the Edit Menu. When graphics are saved, the maximum capacity of 
the Scrapbook file is 32K. For text, maximum capacity is 16K. 

II 
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Exiting the Scrapbook 

You don't have to close the Scrapbook to return to work in your applica
tion. Click anywhere on the window of your application program, and it 
will move in front of your desk accessory. 

Another option for returning to work in your application is to shrink the 
Scrapbook to a portable icon by clicking any part of the Scrapbook 
window while holding down the option key. 

ticns 3:29 PM 

Jerr~ about this, so I hope you don't find my comments too redundant.) 

SpeaKin~ of novelty products, I think we should talK about Tom's jalapeno wine 
proposal. The product mi~ht have some local appeal as a chili seasonin~ or steal: 
marinade, but I have some reservations about the current market strate~y. No 
doubt we'l1 be able to supply you with several ~ood ideas for a mar.:et plan. 

I '11m be in Austin on the 23rd of next month. I look forward to meeting with yO! 

when we review the layouts for the East Coast c8mpai~n. 

To close the Scrapbook, click its close button. Once you've closed it, the 
scrap files you've created will be saved . 
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The Phone Filer 

Clicking the close box 
saves any text entered. 

The tab identifier 
displays first letter· 
of entry name. 

The name fie 

Drag the scroll 
to search for a record 
sequentially. 

The PhoneFiler is an address file and phone dialer for your Apple IIGS. 
It enables you to store address entries, which can be searched, modified, 
or deleted at any time. The PhoneFiler will hold as many entries as the 
memory of your Apple IIGS will allow. 

In addition, you can use your Apple IIGS to instantly dial your telephone 
with the addition of a convenient piece of hardware called a 
HyperDialer. To order a dialer, which comes with installation instruc
tions, see your registration card(In the back of this manual.) 

To open the PhoneFiler, choose it from the" Menu. The PhoneFiler 
window will appear on your screen. Search field 

holds keyword 

Creating a Record 

to be searched. 

Click the Search 
button to initiate 
keyword search. 

The Revert button 
restores the last saved 

version of PhoneFiler. 

Click the Dial button 
to automatically dial the 
currently displayed 
telephone number. 

The Entries display 
reflects the changed number 
of entries in the file. 

A record in the PhoneFiler includes fields for the name, address, city, 
state, phone number, and miscellaneous information. To create a record 

in the address file, click the New button or press O-N. A blank record 
will appear in the PhoneFiler with a question mark (?) in the tab identi
fier at the top, of the record. The insertion point appears at the beginning 
of the first field. 

II 



The name field is designed to hold the keyword you'l! use for searching 
the file. It's important to enter the information in the name field in the 
way that you'l! want to search it later. If you enter first name first, subse
quent searching must be done by first name. If you want to use surnames, 
searching will be done by last name. You have the option of organizing 
the file any way you want, but you'l! probably want to be consistent. 

When you've completed the information in the name field, move to the 
address field by pressing the tab key or clicking in the address field. 

To continue entering information in the appropriate fields, move from 
field to field by pressing tab or clicking in the desired field. When the 
information has been entered in al! the fields, you can click the New 
button to enter another blank record. When you close PhoneFiler, the 
new records you've entered will be saved once again to the disk. 

Changing a Record 

If you want to modify a record in the PhoneFiler, you can do so in several 
ways. If you want to add text to a field or utilize a field you didn't use 
when you created the record, place the insertion point by clicking in the 
desired position and begin typing. The PhoneFiler accessory is similar to 
the others in that each field holds up to approximately 35 characters of 
text. 

If you want to change or delete the information you've entered, place the 
insertion point where the change is to be made. If you would like to select 
a single word, double-click it. Triple-click to select the entire field. You 
can also select text by using the mouse to drag the I-beam over the 
portion you wish to change. Use the Edit Menu commands to cut or copy 
and paste the text into a document or another Phone Filer record. You 
can also use the keyboard equivalents for the Edit Menu commands, .-C 
to copy, .-X to cut and .-V to paste to accomplish the same task. Text 
can be transferred to the Calendar and the NotePad from the PhoneFiler. 
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Searching the File 

To locate a record in your address file, you'll find that you can get to it 
quickly and easily by searching the file. Two types of searches can be 
performed on the address file-keyword and sequential. A keyword 
search is determined by the characters entered in the keyword field-the 
first group of characters in the name field delimited, or followed by a 
blank space. Your files are arranged in alphabetic order by this field. 

To search the PhoneFiler by keyword, move the insertion point to the 
search field either by using the tab key or clicking the field. If you enter 
last name first in the name field of your records, type part or all of the last 
name in the search field and click the Search button. If you enter a 
portion of the name in the search field, all records with keywords that 
begin with those letters will be brought to the front of the file. 
For example, if you' re searching your Phone Filer address book for a par
ticular name but you're not quite sure how to spell it, you don't have to 
enter the entire name to search the file. Enter the first few letters of the 
name, and all the records that begin with those letters will be selected. 
You can continue to search this subgroup of records by repeatedly 
clicking the Search button. Each record will be displayed in alphabetic 
order. 

Mom. I Jonn. BarrB I Jon.s 
Address 13~67 Bra.burn Road 
Cits. State I Auburndale. HE 00020 
Phone- 1(999) 882-0000 

Hisc. I 
~=~~:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=:::::::=::::::::=:::::::~ ~ 0!iiliJ 

Entri.s: U 
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To search for a record sequentially, click the scroll arrow at the bottom of 
the Phone Filer, or drag the scroll box to scan the file for the entry you 
want. 

Deleting a Record 

To delete a record in Phone Filer, locate the record you want to delete by 
using the Search command. When the record you want to eliminate 
appears, click the Delete button, and the displayed record will be deleted. 
The Entries display in the lower-right corner of the PhoneFiler will ret1ect 
the changed number of entries in the file. You can restore any deleted 
records to your file that were previously saved by clicking the Revert 
button. This command restores the last saved version of PhoneFiler. 

If you w,nt to ,ove ,n, lext you've enle«d to the C'l,"~a'i -I 
Appointment Book, PhoneFiler, or NotePad, remember to I 
click the do," box 00 the dd "'''''my window. I 

USing the PhoneFiler Dial Command 

The addition of the HyperDialer enables the PhoneFiler to automatically 
dial the telephone number field in the currently displayed record. The 
sound capabilities of the Apple IIGS make tonal dialing possible. Local 
as well as long distance calls can be dialed with this command. 

The Dial command on PhoneFiler dials the number in the Phone # field 
of any record. The HyperDialer recognizes all numbers and letters, 
taking into consideration both upper and lower case. To enable it to 
handle a variety of types of phone calls that are both local and long 
distance, use the pause character in the phone number. The pause 
character "," inserts a 5 second pause in any phone number, useful for 
pausing before an office extension, or before and after a credit card 
number. PhoneFiler automatically inserts a "I" before a number if there 
are any characters in the area code field. To utilize this feature for same 
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area code toll calls, insert a "-" in the area code field. It won't be 
recognized as a character but will activate the" 1" prefix. 

To Exit the PhoneFiler 

Since new desk accessories can be open on your desktop concurrently 
with an application, you don't need to close them to return to work on 
your document. To place an application in front of the PhoneFiler 
window, click anywhere on the application window. 

Another option involves collapsing the accessory into an icon. Press the 
option key and click on any inactive part of the PhoneFiler window. The 
window will shrink into an icon representing the program. To open the 
PhoneFiler icon, double-click the icon. 

S~ol'ch fOllllOt f&M Siz~ 

Jerry about this, so I hope you don't find my comments-too redundant.) 

Speaking of noyelt~ products, I think we should talk about Tom's jalapeno wine 
proposal. The ~oduct mi~ht haye some local appeal as a chili seasonin~ or steak 
marinade, but I have some reservations about the-current market strategy. No 

doubt we'll be able to suppl~ you with several good ideas for a market plan. 

I will be in Austin on the 23rd of next month. I look forward to meeting with ~OL 
when we review the layouts for the East Coast campai~n. 

To close the PhoneFiler, click the close box. 
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Keymac 

A macro is a small program that consists of a keystroke representing a 
group of letters, words, phrases, or keyboard commands. Through the 
Keymac desk accessory, you can now create sets of macros by assigning a 
multiple-character meaning to a single key. For example, if you were 
writing a report in which a company name is repeated throughout the docu
ment, you could press one key programmed to type the name. This 
function increases your productivity by eliminating the time it takes to 
retype repetitious strings of text. 

You can use the modifier keys such as the control key, the shift key or 
numeric keypad keys to represent a macro, or, if you wish, you can use a 
combination of a modifier key and a letter key to make an endless number 
of new meanings. This accessory makes the task of creating macros easy. 

When you open an application in which Keymac has been installed, the 
macros will be turned off. In order to use the Keymac desk accessory, 
choose it from the" Menu. The Keymac window will appear on your 
screen: 

o Hocroson 
fr ~ Edit keys 

DKey clicks 

~ 
~ 

L....-___ ...L.D-:::.J QD 
form a more ~erfect Union, 
provide for the common defense, 

of libert~ to ourselves and 
for the United States of 

Key: ;:.:Lo::.:be~l: _____ ---, 
[JJ Iby [on Mitchell 

Macro Definition: 
I(c) as7 Stylelfore, Inc. 
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It's important for you to understand the functions of the buttons, boxes, 
and fields displayed in the macro window before you begin creating your 
own sets. 

Creating Macros 

To create a macro. type the character or characters in the Key field that 
you wish the macro to represent. 

Whether you use a single character or a combination of a modifier key 
and a letter key, what you enter in this field will be what you'll actually 
press when you want the keyboard to type the programmed information 
for you. The modifier keys are U key, • key, control key, shift key, and 
the keypad keys. They produce a character which looks like these 
examples: 

.A - The closed apple key and the capital A. 
uA - The open apple key (option key) and the capital A. 

A - The shift key and the capital A (produces a bolded character) . 
• A - The control key and the capital A. 

~ 1 - The keypad one key. 

In the Label field, you'll need to give the macro a name. If you assign it 
an appropriate label that is easy to remember and refers in some way to 
its content, you'll be able to distinguish it from other macros in the list 
box. 

Once you've done this, it's time to assign a new meaning to the newly 
chosen macro. In the field labeled Macro Definition, type the definition. 
You can include as many as 512 characters in the Macro Definition field. 
Once the definition is entered, click Assign; this action completes the 
macro and enters it in the macro list. 

In addition, you can automate keyboard commands that have key equiva
lents such as the Copy, Cut and Paste commands. 
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Creating More Macros 

To create additional macros, click the Clear button to erase the fields in 
the Macro window, and repeat the process described above. The Keymac 
accessory will hold as many macros as memory on your machine allows. 

Editing Macros 

To change a macro or correct a typographical error within the Macro 
Definition field, double-click the macro to select it. Click the Edit Keys 
check box to use the keys listed below. They allow you to edit your 
Macro Definition Field. (The Edit Keys check box is not to be confused 
with the Edit button at the bottom of the screen which lets you edit a 
selected macro.) Then, you can make your corrections. In most cases, 
you'll want to leave the Edit Keys check box activated but turn it off to 
use the Edit Keys as part of your definition. 

The Edit Keys are as follows: 
" key- moves the insertion point to the right one character at a time 
U key- moves the insertion point to the left one character at a time 
Delete key--deletes one character to the left of the insertion point 
Control-X-deletes the whole line 
Control-Y -deletes all characters to the right of the insertion point 
Control-F-deletes one character to the right of the insertion point 
Control-H-moves the insertion point to the left one character at a time 
Control-U-moves the insertion point to the right one character at a time 

U ,-moves the insertion point to the beginning of the field 
U .-moves the insertion point to the end of the field 

U ~ - moves the insertion point 5 characters to the right 
U (- - moves the insertion point 5 characters to the left 
return-moves text to the next line 

If you want to assign a new definition to an old macro, click the Edit 
button at the bottom of the window, type the new information and click 
the Assign button. A dialog box will appear: 
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" Hl~ Edit St¢!'cn fcnsQt f~n\ Siz~ Styl~ C~lOf Opti<ms 1:63 PM 

Keyboard Mucros tes 

Rose, 1. 
This key has already been 
assigned. Replace it? 

aD (Cancel] bai~at 

I II~ 
Key: Label: o form a more perfect Union, 

~ I country I ~,provide for the common defense, 

Hacro Definition: blessin~s of Iibert~ to ourselves and 
Ithe United States of America I ution for the United States of 

Gill) (REIrt&lIe) @~iD ~ ~ 

Click OK to assign the new meaning, or if you wish, click Cancel if you 
decide not to assign a new meaning to the macro. 

Removing Macros 

To remove a macro that has been assigned, click Remove; to erase the 
field, click Clear. All keys can have macros assigned to them except 
control, the 0 key, the esc key, and the delete key. 

Macro Sets 

A macro set is a group of macros combined in a file that can be stored on 
any storage device. When you create a new macro set or load one you 
have saved into the Keymac accessory, it becomes the current or active 
set. A new set will have the macro name, "Untitled." Pre-existing macros 
retain the name given to it when it was saved. To load a macro set, click 
the Open button in your Keymac window. A dialog box appears, giving 
you a list of files on the current path. 

Clicking the disk button allows you to move from one device to another. 
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Macro filt to open: 
~ ISty!ewm31 1. 

Cl Alpha ~ L~Disk ) 
('] fontpoks ad cop~. Without ('] Icons ( Open » Cl Marketing m portr!l~in~ Lone 

( ) I I Cl&se lread~ spoken to Cl Merchandise 

.~ '5 Systlll nMnt.) 
Till ( Conc.l ) 

'--J 

Hocre Dffinition: Id talk about Torn's jalapeno wine 
I jalop.no I appeal as 8 chili seesonin~ or steM 

c:mo (ReIMye) (Rss l qn ) c:lli!D the ctrrent rmet strate~~. No 
is MM ;~ ... Inr. ",.IiI.1 nil. 

When you click the Open button, only the files and folders containing 
macros will appear in bold; all others are dimmed. When you find the file 
you want, click the filename and then click the Open button or double
click the filename. Click the file you want to open, and it will appear in 
the Keymac window . 

• nle Edit Se~rth f~l'Il!Gt font Siz~ Styl~ Col~1 OPtions ~·3B PH 

Macro file to open: 
~ ISty!ewor.31 ndant.) 1. 

Cl Alpba Pl ( Disk ) 
('] Icons jalapeno wine 
(J Marketinginfo (~ Op.n » ('] SHstlil easonin~ or sleak 

I ( elm ) I slrate~~. No 

b ( Cancel ) 'narkel plan. 

'-----' 

Hacro Definition: I look forward to meeting with ~ou 

I I I campai~n 
OE) (Re!Aoye) [Rssi9n) c:lli!D 

,"oro1" 
i;i:; 
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If you decide not to use the macro set after all, you can click the Cancel 
button, and this will return you to the set you were using before you 
clicked Open. 

The Save button enables you to save the macro set you are currently 
working on to a storage device. When you click the Save button, a dialog 
box appears, giving you a list of files on the current path. Clicking the 
Disk button allows you to move from one device to another to determine 
where you want to place the file you're going to save. 

You can create a new folder by typing the name you want to assign it in 
the Save As field. Then click the New Folder button. This creates a new 
folder with the new assigned name on your disk. 

" fll~ Edit Seerth fonsot Font Siz~ St~!~ Colo! OPtioBS 8:26 AM 

Ig) IStyleware31 
nts too redundant.) 1. free: l04k out of BOOk. ( Disk ) 

I Cl finaN .Reot if ("ew~oldtr ) 
D Icons k about Tom's jalapeno wine D letter ( Open ) 

I 

( Clm ) I as 8 chili seasonin~ or steak \.:,.,1 Kul hmibe.Gs 
':~Prodos 

( ) 
U/Tent market strategy. No 

Save as: Suve ideas for a manet p18ll. 
IMARKmM~ I ( Cancel ) 

Macro Definition: IIOilt forward to meeting with ~ou 
111m toAST IIARKfTlN6 I t campai~n. 

ON) (Remolle) (Rssign) Clli!D 
,",,100 ~, 

Save your macro set in the folder by double-clicking the folder to open it, 
deleting the folder name in the Save As field, and then retyping the name 
you wish to give the macro set. Click return or the Save button, and the 
macro will be saved in the new folder. 

You can choose to save to a pre-existing folder by opening it. Once the 
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8/Styl~ware3 

Free: 103k out of BOOk. ( Disk) 

0- (K~w Folder~) 

( Oi>I~1\ ) 

( Close ) 
{J.g:==::=====<iI 

'-Sa-ve-a-s:-----'-"-' ( Sove ) 

IMarketing I ( Cancel ) 

Macro Definition: 
Illest Coost Mark~ting 

location for your macro file has been chosen, type the identifying name 
for your macro set in the Save As field. Press return or click the Save 
button to save the set. 

If you decide not to save, click Cancel, and you will return to the key 

Nacre Drfinitien: 
Illest toast lIarbtilll 
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The New button allows you to begin the creation of a new macro set. It 
clears all of the fields and the list box and changes the macro set name to 
"Untitled." When you click New, a dialog box appears, asking if you 
want to save the old macros. 

If you decide to save them, click the Yes button. If you don't want to save 

Do YOUl'/ish to save the olbaero set'! 

Kev: Label: 
~ r"IHA....;.;RK;....n-'MS-'M-n----

Macro O!finition: 
hl.5t Coast Marketing 

the old set but want to begin with a new one, click the No button. If you 
decide not to begin a new macro set, click Cancel, which will return you 
to the keymac window. 

To add sound effects to your typing, activate the Key Click feature by 
clicking its check box in the Keymac window. 

Exiting the Keymac Desk Accessory 

You don't have to close Keymac to work on your document. Click the 
applications document window, and it will move in front of the desk 
accessory. To close the Keymac desk accessory, click the close box. 
Remember, you must save the macro set you are working on before you 
close the application. 
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Screen Saver 

The Active check box 
turns the Screen Saver off 
and on. 

The Delay settings 
determines time before 
screen darkens. 

~ 
~ 
~ 

The DeskWorks Screen Saver gives you the ability to set the length of 
delay for screen blackout. Using the Screen Saver prevents screen 
burnout when you leave your IIGS on without performing any action for 
long periods of time. To open Screen Saver, choose it from the" Menu. 
The Screen Saver window then appears on your screen: 

1 think we sMul~ talk about Torn's jalapeno wine 
mi~ht he~e some local appeal as a chili seasonin~ or steek 

reservations about the current market strate~~. No 
suppl~ ~ou with severnl ~oo~ ideas for 6 rna~et plan. 

the 23nl of next month. 11001: forwar~ to meeting with ~ou 
for the fast Coast campai~n. 

Sincerel~, 

The window shows an Active check box that turns the Screen Saver off 
and on. You determine the length of time you wish the screen to remain 
on before it darkens by selecting one of the Delay settings. Delay settings 
are the radio buttons displayed in the window. 

Using Screen Saver 

For your convenience, the Screen Saver default setting is preset at 10 
minutes. This means that when you install the program, the screen will 
darken after 10 minutes if the system is not in use. Moving the mouse, 
clicking the mouse button, or pressing any key will result in the screen 
reactivating, and without having to restart your application, your docu
ment is there before you once again. If, however, you want to deactivate 
the Screen Saver, click the check box labeled Screen Saver Active. 



( 

( 

( 

( 

( 

( 

( 

( 

( 

To change a delay setting or the time period of nonuse before the screen 
blacks out, click the delay setting button next to the time you desire. The 
button will appear black, indicating the setting is selected. The Screen 
Saver function can be programmed to activate at 30 seconds, I minute, 2 
minutes, 5 minutes, 10 minutes, 30 minutes, and I hour. 

If you wish to deactivate Screen Saver, touching or moving the mouse 
will restore the screen to its full brightness. 

Exiting Screen Saver 

After you've chosen your delay time, click the close box at the top of the 
window to close Screen Saver or select Close from the File Menu. If 
you've left the Screen Saver activated, your screen will blackout in the 
amount of time you've set. 

1.1 



--------------- --~------
The NotePad 

Click on the 
dog-eared corner 
to turn to the next 
page. 

Click once on the 
uncreased area below 

The DeskWorks NotePad, StyleWare's answer to the office scratchpad, 
can be opened on your desktop whenever you need it. It holds up to 88 
lines of text that you can cut, copy, or paste into your applications. In 
addition, these editing options can also be used to transfer information 
from an application into the NotePad. 

To open the NotePad, choose NotePad from the" Menu, and the 
NotePad window appears on your screen: 

" m~ Edit S~ql'~h fGl'lllot F&M Siz~ St~l~ C&ll)! Options 5:38 PH 
Lttttr 

o Hot@ Pod :~ ~ comments too redundant.) 
Note Pad by Scott Holdalfoy 
(C) StyhWor. Inc., 1987 
I ould talk about Tom's jala~no wine 

ol appeal as a chili seasonin~ or steak 
ut the current market str6te~~. No 
ral ~od ideas for 6 market plan. 

tho I look forward to meeting with ~ou 
oast campai~n. 

Current page 
number 

the dog-eared page to move 
backward one page. 

The NotePad window looks like a notepad on your screen with the 
current page number displayed at the bottom of the page. Upon opening 
the application, the insertion point appears where you last stopped typing. 

• 

Using the NotePad 

When you open the NotePad, the insertion point appears on page l. You 
may begin typing at the insertion point. Each page holds 10 to 11 lines of 
text, which is word-wrapped. However, word wrapping text is not con
tinued from one page to the next. In order to continue typing when you 
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reach the end of one page, you must click on the dog-eared comer to tum 
to the next. The purpose of this feature is to give you the ability to 
separately save notes that vary in subject matter. It's important for you 
to know, however, that the text you type into the NotePad is always in the 
system font. No font or style changes can be made within the accessory. 

Changing Pages 

To tum the NotePad page, click the dog-eared page comer at the bottom 
of the pad. You'll move forward in the NotePad one page. To move 
backward through the NotePad one page at a time, click once on the 
uncreased area below the dog-eared page. You'll then move backward 
through the NotePad one page at a time. 

Cutting, Copying, and Pasting 

Text can be transferred from the NotePad to the application in which 
you're working and from your application to the NotePad by using the 
Clipboard. NotePad supports all Clipboard operations except the Undo 
command. 

To copy NotePad text to an application, select the text you want to 
transfer by using the mouse to position the insertion point at the begin
ning of the text. While holding down the mouse button, drag the insertion 
point along the length of the line or lines you want to select. To select a 
line in the NotePad, place the insertion point anywhere in the line and 
double-click. The next word is to use the Cut or Copy commands from 
the Edit Menu to put the text onto the Clipboard. From the Clipboard you 
can paste text into the application open on your desktop by positioning 
the insertion point in your document where you want to place it and then 
choosing Paste from the Edit Menu. 

To cut or copy text from an open application into the NotePad, choose the 
appropriate commands from the Edit Menu to transfer text onto the 
Clipboard. Open the NotePad from the collapsed icon or bring the 
NotePad to the front of your desktop. Tum to the page where you want to 
place the text, and use the Edit Menu's Paste command to place the text 
into the NotePad. 



Exiting the NotePad 

You can either close the NotePad by clicking the close box or choosing 
the Close command from the File Menu. When you close, everything 
you've added to your NotePad is saved. To clear the text from the 
NotePad, you must use the Edit commands. 

Since DeskWorks is a new desk accessory, it can remain open on the 
desktop along with an application. As a result, you can bring an applica
tion in front of the NotePad by clicking its window. You can also 
collapse the NotePad into an icon by holding the option button and 
clicking on the NotePad window. This icon can be moved anywhere on 
your desktop and can be brought back to its full size by double-clicking 
the icon. 

~rry about this, so I hope you don't find my comments too redundant.) 

5peakin~ of noye1t~ prnducts, I think we stKIuld talk ohout Torn's jalapeno . 
If'OIIosa1. The product mi~t have some local appeal as a chili seasonin~ or 
rMrinade, but I have some reservations about the current market strate~~. 
doubt we'll be able to suppl~ ~ou with several ~ood ideas for a market plan. 

I will be in Austin on the 23m of next month. I look forward to meetin~ with 
wilen we review the l8IJouts for the East Coast camp8i~n, 
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----------.-----------The Calculator 

Logarithm key 

Trigonometric --t--f-
Functions 

Scientific 
Notation key 

If you need to do a quick computation, the DeskWorks Calculator gives you 
an accurate answer in minutes. With such added features as ten memory 
registers to store variables, it provides the convenience of an on-line 
scientific calculator to use with your IIGS applications. 

To use the DeskWorks Calculator, choose Calculator from the" Menu. 
To close the accessory, click the Off button in the upper-right comer of 
the Calculator. 

Memory keys 

Calculator Function Keys 

The standard order of calculation in which mathematical operations in a 
single equation are performed is as follows: 

o Powers and roots 

@ Multiplication and division 
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@) Addition and subtraction 

9 Equals (El ) 

The Parentheses Keys 

In many situations, you may need to specify the order in which calculations 
are evaluated or the way in which numbers are grouped together as a 
problem is solved. Parentheses allow you to do this. With the DeskWorks 
Calculator you're allowed to use up to 14 nested sets of parentheses in an 
equation. Use parentheses to determine an intermediate solution in an 
exceptionally long problem or to tell the calculator what part of the problem 
to perform first. Thus, the expression 8 - 3 * 2 always produces a result of 2, 
since multiplication takes precedence over subtraction and so is performed 
first. 

With your Desk Accessories Calculator, you can use the OJ and IJ] keys 
to change the order of calculation since operations contained within paren
theses are performed first without regard to other rules of precedence. 

EXAMPLE: 
Change the order of calculation for 8 - 3 * 2 = x so that subtraction is 
performed first. 

key in: 8 - 3 IJ] 12) 2 El 

result: 10 

Note that it's not necessary to enter both parentheses if one occurs at the 
beginning or the end of the calculation. 

Memory Keys 
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The memory function keys on the DeskWorks calculator make it possible 
for you to record combinations of keystrokes to be used at any time 
during your session. You can also make use of 10 memory registers 
(storage locations) for storing values. 

~- Insert the displayed value in memory. 

c:u:!] - Add the displayed value to the value in memory. 

c::ti::J - Subtract the displayed value from the value in memory. 

r:u:§]- Displays the current value held in memory. 

I STO 1- Stores values in separate memory locations numbered 1-10. 
Refer to these locations as variables in equations, or small 
programs on your calculator. 

I REC 1- Turns on the record function--every key you press will be 
recorded until you click Stop. Use it for formulas. 

~- Activates the keystrokes you've stored by using the Record 
button. 

~- Recalls values from memory locations 1-10. 

These functions allow you to save keystrokes by storing entered or 
calculated values for use in later calculations. 

Note: All recorded and stored values are saved until you replace 
them or restart the computer. 

Scientific Notation Uil 

In scientific notation, numbers are expressed as a single positive value or 
base number (usually referred to as the mantissa) multiplied by 10 raised by 
the value of an exponent. This exponent can be either positive or negative, 

• 
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thus allowing scientific notation to be used for both very small or very large 
numbers. For example, in scientific notation the number 5,216,700 can be 
expressed as 5.2167 X 106, while the number 0.000031 can be expressed as 
3.1 X 10-5• 

To enter a number on the Calculator using scientific notation: 
• enter the mantissa 
• press ~ (EE stands for enter exponent) 
• enter the exponent (if it's negative, click +-) 

EXAMPLE: 

Enter the value 123,197,000 in scientific notation. 

key in: 1.23197 [ll] 8 

result: 1.23197 E08 

EXAMPLE: 

Enter the value 0.0000000008 in scientific notation. 

key in: 8 10 ~ I}) 

result: 8.0 E-I0 +/-

Logarithm Keys: 

~ [£J [2] kOGJ 
Logarithms are used in engineering and scientific applications when 
calculations must be performed on large numbers. 

Although common logarithms use a base of 10 (i.e., log 10 x = y), one log 
that has proven to be particularly useful over the years is a naturalloga-
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rithm that uses a special number (approximately 2.718281828) for its base. 
Your DeskWorks Calculator includes both a natural logarithm key QLOG:<i) 
and a natural antilogarithm key (r::::!2:]). 

EXAMPLE: 

Compute the natural logarithm of 12. 

key in: 12 kOGJ 

result: 2.4849066 

EXAMPLE: 

Compute the natural antilogarithm of 2.4849066. 

key in: 2.4849066 r::::!2:] 

result: 12 

Trigonometric Functions 

Cll!il I TAH I ~ lSI H-i I hAH-ilkos-il 

As you probably remember from high school math class, trigonometry is a 
science devoted to the study of triangles. But, unless you use "Trig" in your 
work, you've more than likely forgotten that trigonometric functions were 
developed especially to deal with right triangles and the three relationships 
found within their composition. And, unless you've played Trivial Pursuit 
lately, you probably don't recall that these relationships are called the Sine, 
Cosine, and Tangent. 

The DeskWorks Calculator not only provides keys that represent each of 
these three relationships, but it also gives you the inverse of Sine, Cosine, 

• 
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and Tangent. Use these keys to simplify such chores as measuring floor or 
wall space and determining the size sail needed to equip your sailboat. 

Sine function: sin A = alc 

Cosine function: cos A = blc 

Tangent function: tan A = bla 

Your Desk Accessories Calculator provides both the standard trigonometric 
functions (c:::ElL) ~ ~), as well as their inverse functions 

( lSI N- i I kos-il ITfiN-il ). 

EXAMPLE: 

Find the sine of a 30° angle. 

key in: 30 c:::ElL) 

result: 0.5 

EXAMPLE: 

Find the angle that has a sine of 0.5. 

key in: .5 ISIN-il 
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result: 30 

Miscellaneous Function Keys: 

[2J [l) I1il ~ ~ 15) [i) CO [2J 

Other function keys on your DeskWorks Calculator include the following: 

[2J - Calculates the square of the displayed value 

[l) - Calculates the square root of the displayed value 

[2J - Raises the value of x to the power of y 

EXAMPLE: 

Find the cube of 112. 

key in: 112 [2J 3 G 

result: 1404928 

co - Calculates the reciprocal of the displayed value 

EXAMPLE: 

Find the decimal equivalent of 3/16. 

key in: 16 CO [;] 3 G 

result: 0.1875 



m - Changes the sign of the displayed value 

Gil - Displays the value ofrc to 11 places (3.14159265358) 

lIB Sets the displayed value of the angle to be entered in radians or 
degrees 

~ - Converts the displayed angle in degrees to radians (a radian is 
defined as 180/rc) 

[i!iil - Converts the displayed angle in radians to degrees 

EXAMPLE: 

Change 90° to radians. 

key in: 90 [i!iil 

result: 1.57079632679 

~ - Generates a random number 

I:J - Number in the display is converted to decimal percent 

IZl - Takes the number in the display and multiplies it by itself. 
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Mr. Apple 

Mr. Apple is the new animated addition to the Menu Bar. Located to the left 
of the File Menu, the rotating colors of the apple icon come to life once it is 
properly installed. If you want to deactivate Mr. Apple, choose it from the 
" Menu, and click the Mr. Apple Active check box. To reactivate Mr. 
Apple, click its check box again. 

-- --------------

Alarm Clock 

The Alarm Clock not only gives you the date and time, but it also acts as an 
alarm system with snooze control. To activate the clock, select it from the 
" Menu. Once the alarm clock window appears, you'll see the current date 
listed on the left and the time on the right. The Alarm Clock is divided into 
two portions-the clock and the alarm. 

Letter 
o AlormClock find my comments too redundant.) 
11/2187 6 : 37: 50 PH 

6:37 PH 
Clicking the Daily 
button results in 
alarm going off 
everyday at a preset 
time. 

( The On button 

( 

( 

activates the alarm. 

The Off button --I-+-f?n~~llirin~~~~t=~~~~~:~~--llJL The Future Date 

The Snooze buttontn~~SI~\DD~Z~I~ ~~Z=~J 
button sets alarm 
for a future date. 

The Next Day button 
sets alarm for next day. 

when 
. on the 23rd of next month. I look forword to meetin~ with ~ou 

eview the lo~outs for the East Coost com~oi~n 

To change Clock settings, click on one of the number fields. A smaller 
window will appear with buttons under the date and time that are labeled 
Restore and Set. 



L.:===~~~!J we should talk about Tom's jalapeno wine 
proposa\. The product mi~ht he~e some localeppeeles a chili seesonin~ or steak 
marinade, but I have some reservations about the current market strate~~. No 
doubt we'll be able to suppl~ ~ou with several ~ood ideas for a merlet plan. 

I will be in Austin on the 23rd of next mooth. Iloo~ forward to meetin~ with ~OII 
when we review the le~outs for the East Coast camp8i~n. 

~ 
~ 
~ 

To change the number you've highlighted, use the t and J, keys. To move 
horizontally from one number to the other, use the ~ and ~ keys, the tab 
key, or click your choice. Once your changes have been made, click the Set 
button. To return to the original clock window as it was before you made 
changes, click Restore. When you click either the esc key or the Set or 
Restore button, the complete Alarm Clock window will reappear on your 
screen. 

To set the alarm, change the alarm setting to the appropriate time, click the 
On button, and then click the Daily button. When the time comes, the 
alarm will sound, and the screen will flash. Remember, however, that in 
order to hear the alarm sound, your computer volume must be turned up. 

To turn off the alarm, you can either press return, or click the Off button, 
the Snooze button, or the Next Day button. 

If you wish the alarm to go off at some time in the future, click the Future 
Date button. When you do this, a second date will appear to the left 
under the Alarm Settings heading. This is where you'll need to put in the 
date you wish the alarm to sound. Don't forget, though, to also designate 
the time of day in which you want the alarm to alert you, whether it be in 
the A.M. or P.M. 
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----------.------- --_ .. __ .-

To set the snooze, use the tab key or the -7 and f-- keys to highlight the 
snooze time, which will cause the alann to repeat at whatever interval 
you designate. This feature works the same way as a regular alarm clock 
in that if you set it to go off every five minutes, for example, it will sound 
every five minutes to remind you that it's not Saturday. 

If, however, you want to turn off the snooze for today but want to 
program it to go off tomorrow, click the Next Day button before you turn 
off the alann. To exit Alarm Clock click the close button or press the esc 
key. 

-----------------_._------_. ---

The Menu Clock 

I~IIII 

The Menu Clock appears as part of the menu bar on the upper-right 
corner of the screen. It displays the current time in hours and minutes. 
Once installed, this feature is present as long as your screen is lit. The 
Menu Clock is located in the System. Setup folder that is located in the 
System folder on the DeskWorks disk. 

SYSTEM. SETUP 

• 



The System Clock 

Enigma 

The System Clock is located in the Desk.Accs folder in the System 
folder of the DeskWorks disk. 

The clock gives the current time and date and can be moved anywhere on 
the screen. To close the system clock file, click its close box. 

Enigma is a game of logic designed for one player. The object of the game 
is to use the process of elimination to arrange colors in the correct sequence 
that has been randomly chosen by the program. 

To open Enigma from the desktop of your IIGS application, choose Enigma 
from the '* Menu. 

When the Enigma window opens, you'll see a blank rectangle at the top of 
the dialog box containing a secret code. Under the code box are 12 
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is contained in the 
blank rectangle. 

Click your 
answers in 
the Try box 

The Quit button 
stops the current game. 

The New button 
starts a new game. 

Color palette 

think we should talk about TOOl's jalapeno wine 
some local appeal as a cIlili seasDftin~ or steal: 

ooout ttle current martet stl'8tegy. ~ 
with several ~od ideas for a martet plan. 

~1""""1W..I~~~~--------JU"--.1 The OK button 
'T----,'------' allows you to test 

your try. 

rectangles, each containing five squares that take on the colors you assign 
them. To play the game, first click one of the eight color squares on the 
color palette that runs vertically on the right-hand side of the game. Then 
click the first color in the first rectangle, continuing horizontally until all 
five colors are revealed. Each of these boxes, once opened, becomes a 
color that mayor may not be a match to the code. 

After every sequence of five colors is revealed, click the OK button to 
test your try! This action provides you with clues in the form of X's and 
O's that appear in place of the five question marks on the corresponding 
line of the sequence you've just uncovered. If you've picked any of the 
correct colors in the secret code, an 0 will appear on the dotted line 
beside the try box. In addition, if a matching color is in the correct 
position in the sequence, an X will appear on the dotted line beside the 
box. If you get a line ofX's on the clue line, you'll have broken the code, 
and the correct answer will appear in the secret code box. 

Other buttons below the puzzle allow you to stop playing the current 
game or choose a new one. Click Quit to stop playing the current game 
and New to continue with a new one. 
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------------- -----------

If you're in the middle of a particularly interesting game and your boss 
walks in, you don't need to close Enigma to return to your application. 
Since it is a new desk accessory, it can stay open on your desktop while 
you work yet not be visible. You can hide your game by clicking 
anywhere on an application window to move it in front of Enigma. Click 
again to bring Enigma forward. 

You can also reduce the game to a movable icon by holding down the 
option key and clicking anywhere on the Enigma window. 

Jerr~ about t~is, so I ~ope ~ou ~on't find m~ comments too re~undant) 

SpeaKin~ of nove1t~ pro~ucts,1 think we should talk about Tom's jalapeno 
proposal. T~e pro~uct mi~ht ~ave some local appeal as a c~ili seasonin~ or 
marinade, but I ~aye some reservations aDOllt tM current market strate~y 
doubt we'll De able to suppl~ you wit~ severBl ~oo~ i~eas for a market plan. 

I will be in Austin on the 23r~ of next month. I look forward to meetin~ 
w~en we review the la~outs for the fast Coast campai~n. 

To retrieve the old game and expand the window to full size, double click 
on the icon. To close Enigma, click once in the close box or choose Close 
from the File Menu. Remember, however, that if you're in the middle of a 
game when you close, it's lost forever, and reopening Enigma will result 
in your having to start a new game . 
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CHAPTER THREE ... ... ... 
Practical Uses for DeskWorks 

As you become more familiar with your DeskWorks accessories, you'll find 
more and more ways to incorporate them into your daily life. This chapter 
provides you with sample applications that ask you to use the Calculator 
and Keymac to find solutions. These exercises will not only give you a little 
practice using the accessories, but they may also make you more aware of 
possible everyday uses. 

Calculator Application 1 

On homecoming weekend you return to your old high school for your ten 
year class reunion. You're eager to see all your former classmates at the big 
game and wonder if they'll think you've changed. As you walk up the 
bleachers, however, the first person you recognize is your old chemistry 
teacher, Mrs. Withers, the one who terrorized the entire senior class. Seeing 
her once again calls to mind many bad memories in her class. 

For some reason, you could never answer her questions. You even remem
ber the one you failed to answer the last day of class. When you return 
home, you decide to use your DeskWorks Calculator to find out once and 
for all the answer to her query, "If 250 ml of gas is heated from 20° C to 
40° C, what is the volume at the higher temperature, assuming that the 
pressure remains constant?" Here's how you would go about finding the 
answer: 

The volume of a gas is proportional to the temperature as follows: 

V2 = VIT2/ TI 

where VI is the original volume, V2 is the new volume, TI is the original 
temperature, T2 is the new temperature, and where temperature is expressed 
as absolute temperature ° C + 273. 

1'1 



Key In: 

250 [2) [I) 40 G 273 rn [I) 20 G 273 rn 

Result: 
Approximately 267.1 ml 

Calculator Application 2 

You answer an ad from a top radio station in your city that needs someone 
who is not afraid of a challenge. The person chosen to fill the position will 
have a good chance of climbing to the top of radio broadcasting. When you 
get to the station, however, the manager hands you a tape measure and asks 
you to climb their transmission tower in order to measure it. Fortunately, 
you've noticed that at 200 feet away, the top of the tower can be sighted 
with a 35° angle of elevation: 

A~ __ ~~ __________ ~~ 
Approach: 

200' 

Rewrite the tangent function (tan A = alb) to solve for the variable a: 
Tan A * b = a 

Key In: 
35 ~ [2) 200 El 
Result: 
Approximately 140 feet 

~ 
~ 
~ 



Calculator Application 3 

Although you really want a motorcycle, you purchase a car for $10,000, 
putting $2000 down. The loan is for 3 years at 15% annual interest. What 
is your monthly payment? 

Approach: 
Monthly payments can be determined with the following formula: 

P = PV(l - (l + I) Nil) 

where P is the payment amount per period, PV is the present value, I is the 
interest per period, and N is the number of periods. 

Key In: 
1 G IT} 36[!}.15G 121]] [ZJ 36 [i) IT} G I]] 

.15 G 12 El c:o [2) 8000 El 

Result: 
$277.32 per month 

----_._----

Calculator Application 4 

On the advice of your brother-in-law, you've invested $100.00 at 4.5% 
annual interest. He claims you'll double your money "almost overnight." 
With his track record, you decide you had better find out for yourself. 

Approach: 
Compound interest can be determined by the formula: 

FV = PV (l + I)N 

where FV is the future value, PV is the present value, I is the interest per 
period, and N is the number of periods. 

II 



To discover the value of N, you can rewrite the formula using natural 
logarithms: 

N = Ln (FV / PV) / Ln (l + I) 

Key In: 
200 G 100 El ~ G III .045 G 12 @ 1 I]] 

~ El 

Result: 
Approximately 185 months---or over 15 years 

Calculator Application 5 

As a former admiral in the Swiss navy, you still take a keen interest in 
nautical matters. One evening you notice two ships offshore. You estimate 
that ship A is 3.5 miles from ship Band 2.0 miles from where you stand on 
shore. The two ships form an angle of 450 • You want to figure how far 
ship B is from your position. 

Ship A 

~3.5Miles 
~ 

Shore L-_:.....-___________ ~ Ship B 
2 Miles ------I.~ 

Approach: 

Two sets of equations that apply to all triangles can be used here: 

a/sin A = b/sin B = c/sin C 

A + B + C = 1800 
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Where: 

Since you know the values of C, b, and c in this case, you can determine B 
with b/sin B = c/sin C by rewriting it as sin B ;:: (b)sin C/c and then using 
the arc sine function. 

Key In: 
2 5) 45 I.:!i!il B 3.5 E} lSI 1ft r 
Result: 
Approximately 23.80 

Now you can use the value of B to determine the value of A by rewriting A 
+ B + C = 1800 as 1800 - (B +C) = A 

Key In: 
180 G 23.8 G 45 E} 

Result: 
111.20 

You're getting close now. Calculate the value of a by rewriting alsin A = 
c/sin C as a = c(sin A )/sin C. 

Key In: 
3.5 5) 111.2 I.:!i!il B 45 I.:!i!il E} 

Result: 
Approximately 4.6 miles 

II 
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Calculator Application 6 

After glancing at your bank statement today, you had the sinking feeling 
that you may be overdrawn. Though you recently made a deposit, you've 
been writing quite a few checks lately. You immediately go to your Apple 
IIGS and open the Calculator. 

The first thing you'll need to do is check off those checks which have 
cleared the bank. You've made two deposits that weren't on the statement 
which also didn't retlect the current service charge. All of these must be 
included in your calculation. The formula for doing this is as follows: 

Balance on statement - checks outstanding + deposits - service 
charge = current balance 

The balance on your statement is $1,126.03, and yesterday you made a 
$500.00 deposit. Outstanding checks total $1,801.50. The service charge is 
$8.00. Find your current balance. 

Key In: 
1126.03 G 500 G 1801.50 G 8 El 
Result: 
You're in trouble. You're $183.47 overdrawn. 

Keyboard Macros Application 1 

~ 
~ 
~ 

Keyboard macros can be useful in your word processing documents as 
shortcuts for doing any number of writing and editing tasks. 

You can create a macro to automatically enter a letter heading for all your 
documents. 

First, enter the key you'll press to call your macro. For this example, we'll 
use the 3 key on the numeric keypad. (You can use any key on the key
board, but it's better to use either the keypad keys or a control-key combi
nation to prevent interference with your typing when the macros are on.) 
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• Enter the macro key by pressing the 3 key on the numeric 
keypad. 

Ke~: 

~ 
• Enter the name you want to give the macro. 

Label: 
ILetterhead 

For example, let's give this macro the name "Letterhead." 

• Enter the definition of the macro by typing the keys which 
will make up the macro. 

Macro Defini tion: 
1 4628 Pa 1m Avenue ~ Hous ton, Texas 77411 

In this example, we'll type: Alan Smith <carriage return> 4628 Palm 
Ave.<carriage return> Houston, Texas <carriage return> 77438 <carriage 
return>. 

• Click the Assign button to enter it into the list. 

fI 
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Keyboard Macros Application 2 

Henry R. Baker has a cookie company and sells exclusively to three major 
wholesalers. His business has really grown, and so to provide his customers 
with a variety of sizes, he now bundles his cookies in one of four different 
packages. Mr. Baker uses an Apple IIGS to type all of his forms and 
invoices as well as assist his secretary with other record keeping duties. Mr. 
Baker would like to simplify the task of filling out his forms and at the same 
time eliminate so much repetitive typing. 

Miss Wise, the company secretary, decides to set up macros in which the 
company information, the wholesalers information (one macro for each), 
and the customer numbers are represented. She creates a form and a macro 
set to cover names, addresses, and account numbers. She also creates 
macros that represent quantity information used in placing orders. This is 
how she does it: 

Before creating the macros, tabs must be set in the ruler (Multi Scribe GS is 
used in this example.) A tab is set for the beginning of each of the fields on 
all of the lines. 

Miss Wise sets up a macro to produce the form . 

• Enter the key you'll press to call the macro. 

Ke!t: 

~ 
• Enter the name for the macro. 

label: 
I Form 1 
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• Enter the definition of the macro. 

Type the following information: 

Pay: <carriage return> <carriage return> Sold To: tab tab tab Ship To: 
<carriage return> tab Name: tab tab Name: <carriage return> tab Address: 
tab tab Address: <carriage return> tab City, State, Zip: tab tab City, State, 
Zip: <carriage return> <carriage return> <carriage return> Customer 
Number: tab tab Date: <carriage return> <carriage return> Qty: tab 
Description: tab tab Package #: tab Amount: <carriage return> <carriage 
return> <carriage return> <carriage return> <carriage return> <carriage 
return> <carriage return> tab tab tab tab Total: <carriage return> 

Macro Defini tion: 
ra~:~~So 1 d To:-+HHIShip To:~-+IMame:-+HI 

Once she creates the form, she makes macros to fill out the form automati
cally. First she makes a macro to enter the name and address of the Baker 
Cookie Company in the "Pay:" field. She uses the 2 key on the numeric 
keypad and assigns this address to the macro definition: 

Baker Cookie Company 
10876 Dairy Ashford 
Houston, Texas 77024 

Then she creates three macros to represent each of the three wholesalers. 

When she finishes, she has an automatic billing system built into her word 
processor. Mr. Baker is so pleased with her work that he gives her a 10¢ an 
hour raise! 

• 
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Reference Chapter 

DeskWorks Original Defaults and Disk Capacity 

Mr. Apple: active 

Alarm Clock: Off button selected 
Future Date selected 
time and date current 

NotePad opens to page 1 of NotePad 

Calendar current date selected 

Calculator clear memory registers 
clear memory 

PhoneFiler opens to StyleWare technical support address 

Scrapbook opens with author's name 

Keymac macros unactivated 
Fields and list box empty 
Edit Keys box 
Current macro set-untitled 
cookie company example (active macro set) 

Screen Saver active 

Enigma none 

Menu Clock active; time current 

System Clock active; time current 
(Clock) 

2.5K 

IO.5K 

10K 

15K 

15K 

20K 

18.5K 

17.5K 

7.0K 

6K 

2.0K 

1.5K 

II 



(The Finder, the application for organizing and managing your documents, 
occupies 5 I K.) 

Special Files and Folders 

Each of the desk accessories listed below has its own auxiliary file where 
data is stored. The first time you save data with an accessory, a file is 
automatically created to hold this data. For example, when you save a 
macro set you've created, it's saved in a file called Keymac in the Style
Ware folder located in the System folder on your application disk. When 
you install DeskWorks in a new application, you'll want to transfer these 
files to be able to use the data you've created. To transfer these files into 
your application, see Chapter I, "Installing Desk Works." 

The following information will assist you in locating specific auxiliary files: 

NotePad 

Calendar 

PhoneFiler 

Screen Saver 

The NotePad file is located in the StyleWare folder in the 
System folder on the DeskWorks disk. 
/Style Ware.DW /System/Style Ware 

The Caldata file is located in the StyleWare folder in the 
System folder on the DeskWorks disk. 
/StyleWare.DW/System/StyleWare 

The Phone. list file is located in the StyleWare folder in 
the System folder on the DeskWorks disk. 
/StyleWare.DW /System StyleWare 

The file is located in the Desk.Accs folder called 
Saver.data. 
/Style Ware.DW IDesk.Accs/Saver.data 
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TIP: 

The System 
Clock 

Menu Clock 

Scrapbook 

This clock is located in the Desk Accs. folder in the 
System folder on your DeskWorks disk. 
StyleWare.DW/System/Desk.Accs 

MenuClock is located in the SYSTEM.SETUP folder in 
the SYSTEM folder on your DeskWorks disk. This is the 
only accessory program that is not found in the 
DESK.ACCS folder. 
/StyleWare.DW/System/System.Setup 

The Scrapbook is located in the Scrapbook folder in the 
STYLEW ARE folder in your SYSTEM folder on the 
DeskWorks disk. 
/Style Ware.DW /Stystem/Style Ware/Scrapbook 

In Chapter 2, you learned two ways to create a scrap file. Another 
method to accomplish this same task is to use the Finder. Drag 
PICT and text file icons directly into the Scrapbook folder in the 
STYLEW ARE folder located in the SYSTEM folder. The files you 
place in this folder must already be files saved in PICT format or 
ASCII format. The number of scrap files the Scrapbook folder 
can hold is limited by the capacity of the boot disk. 
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Glossary 

antilogarithm 
The number for which a given logarithm stands. 

backup 
A duplicate of a disk. 

Clipboard 
The storage part of memory that stores what you last cut or copied. 

clip rectangle 
The result of action taken in the Scrapbook operations. 

delimited (to delimit) 
To mark the beginning or end of a sequence of characters with the use of a 
character that is used for punctuation. The delimiter itself is not considered 
part of the sequence itself. 

desk accessories 
Small applications such as the Calculator, NotePad and Keymac that can be 
run from the desktop of a main application program without having to quit 
the main program. If you have desk accessories installed, they'll appear on 
the. Menu, regardless of the application program you're running. 

desktop 
The computer's working environment. The desktop includes the Menu Bar 
and the empty light blue area beneath that resembles a real desktop. 

Finder 
An application that allows you to use, organize, open and close documents. 

Hyperdialer 
A phone dialer you can order that will enable you to use your Apple IIGS to 
dial phone numbers. 

icon 
A small picture on the desktop that symbolizes an object such as a folder, a 
function, or message. 
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key field 
Input bar in the Keymac window where you type the character or characters 
you wish to take on a meaning, resulting in the creation of a macro. 

keyword 
Refers to a PhoneFiler method of locating names and addresses whereby 
files are searched according to characters entered in the keyword field 
labeled Search. 

logarithm 
The exponent indicating the power to which a fixed number, the base, must 
be raised to produce a given number. 

macro 
A small program that consists of a keystroke representing a group of letters, 
words, phrases, or keyboard commands. 

macro set 
a group of macros combined in a file that can be stored on any storage 
device. 

mantissa 
In scientific notation, refers to numbers expressed as a single positive value 
or base. 

modifier keys 
They are rj key, control key, " key, shift key, and the keypad keys. 

natural antilogarithm 
A number for which a given logarithm stands. 

natural logarithm 
The exponent indicating the power to which a fixed number, the base, must 
be raised to produce a given number. 

record 
A file in the PhoneFiler that includes a name, address, city, state, phone 
number, and miscellaneous information. 
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scrap file 
One piece of text or graphic image that has been saved into the Scrapbook. 

sequential 
A method of search where PhoneFiler records are searched in order accord
ing to their alphabetic sequence. 

tab identifier 
Similar to tabs found on manila folders that contain the first letter of the 
first word listed on the record. 

try box 
The input bars in Enigma where the player records his choices. 

uninitialized disk 
A disk that has not been formatted. 
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INDEX 

A 
addition 54 
addresses 35-39 

creating address files 36 
Alarm Clock 61-63 

changing settings 61 
close box 61 
Daily button 61 
date and time (current) 61 
date and time (Alalm Setting) 61 
default setting 81 
disk capacity 81 
Future Date button 61 
keyboard arrow keys 62 
location of folder 83 
Next Day button (Snooze control) 61 
Off button 61 
On button 61 
opening Alarm Clock 61 
Restore button 62 
Set buiton 62 
setting 61-63 

alalm on daily basis 61-62 
for a future date 62 
date and time 62 
snooze control 63 
Snooze button 62 

antilogarithms 56-57 
antilogarithm key 56-57 

Apple /I System Utilities Disk 4 
applications (sample) 67-77 

using the Calculator 67-74 
using keyboard macros 74-77 

Appointment Book 23-27 
accessing the Appointment Book through 

the Calendar 24 
Cancel button 25 
clearing old entries 25-27 
closing 26, 27 
cutting, copying, and pasting 25,26-27 

default 81 
disk capacity 81 
Edit commands 26 
entry fields and text capacity 26 
exiting Appointment Book 26, 28 
field capacity 26 
functions of 26 
location of file 82 
making changes 26,27 
making entries 26 
OK button 25 
Open button 24 
opening 29 
saving entries 28 

arc cosine function 57-58 
arc sine function 57-58 
arc tangent function 57-58 
Assign button (Keymac) 40,41 
audodial function 35 

B 
backing up your DeskWorks disk 4-7 
backups 4-7 

C 
Calculator 53-60 

addition 54 
antilogarithm 56-57 
closing Calculator 53 
data entry keys 55-60 
default settings 81 
disk capacity 81 
exiting Calculator 53 
function keys 53-54 
functions of 53-60 
logarithm 56-57 
mantissa 55-56 
memory keys 54-55 
multiplication 53 
powers and roots 53 
parentheses keys 54 



parentheses keys 54 
sample applications using 67-74 
scientific notation 55-56 
trigonometric functions 57-60 

Calendar 23-28 
changing the date~day, month, year 

24,25,26 
Close box 24 
Clear button (Keymacs) 40 
Clear Old Entries button 24, 27 
Current Date button 24 
collapsing to 28 
default settings 81 
disk capacity of 81 
Edit commands 41 
exiting the Calendar 26 
Last Year button 24 
location of Calendar file 82 
Month button 24 
Next Year button 24 
Off button 24 
Open button 24 
selecting scrap files 30 
using Appointment Book through 

Calendar 26 
using Calendar 25 

Cancel button 27 
Appointment Book 27 
Scrapbook 29 
Keymac 45,46 

changing 
Alarm Clock settings 61 
Appointment Book entries 27 
Calculator functions 53-54 
Calendar settings 24, 25, 26 
macro meanings 42,47 
Menu Clock settings 63 
NotePad pages 50-52 
PhoneFiler entries 36-37 
System Clock settings 64,81 

Clear button (Keymac) 39,42,37 
Clear old Entries button 24, 27 
clip operations (Scrapbook) 31 
Clipboard operations 4 

Clocks 

with Appointment Book 25, 26-27 
with NotePad 51-52 
with PhoneFiler 36-37 
with Scrapbook 30-32 

see Alarm Clock 61-63 
see Menu Clock 23, 63 
see System Clock 23,64 

Close box 
Calendar 24 
Enigma 65 
Keymac 40,47 
Menu Clock 63 
Mr. Apple 61 
NotePad 50, 52 
PhoneFiler 35 
Scrapbook 29 
System Clock 64 

collapsing icons (see each desk accessory) 
copying disks (see making backups) 
Copy II Plus Utilities 4 
Cosine function 57 
creating 

address files 35-39 
scrap files 30 
notepad files 50-52 

cutting, pasting, copying (see Edit commands) 

D 
data entry keys 55-60 
date 

entering in Alarm Clock 62 
entering in Calendar 25, 26 

default settings 81 
Delay setting (Screen Saver) 48 
Delete button (PhoneFiler) 35 
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delimited 37 
Desk.Accs folder 7-8, 12-15 
desktop iv, 4, 6, 28, 52 
Desk Works Accessories 

backing up 4-7 
date on each desk accessory 

(see individual listings) 
default settings 82 
disk capacity 82 
installing 7-16 
location of auxiliary files 83 
removing 16 

DeskWorks folder icon 6,7,9, 11-17 
Dial button (PhoneFiler) 35 
dialing procedures 35 
Disk button (Scrapbook) 29 
disk capacity of desk accessories 81 
disk drives 

uses of 3.5-inch disk drive 4, 7-8, 12 
uses of 2 system drive 5, 8-11, 17 

division 53 
"Don't replace any duplicate items" folder 9 

E 
Edit button (Keymac) 40,42 
Edit commands 

uses with desk accessories 
(see each desk accessory) 

Edit keys(Macros) 42 
Editing 

entries 

Appointment book entries 26 
macros 42 
NotePad entries 50-52 
PhoneFiler entries 36 
scrap files 30, 31 

Appointment Book 23 
Keymac 41 
PhoneFiler 36 

Enigma 64-66 

Close box 65 
collapsing icons 66 
directions 64-65 
New button 65 
OK button 65 
Quit button 65 
try box 65 

Exiting DeskWorks accessories 
(see each desk accessories) 

Eve field (Appointment Book) 25 

F 
field capacity (see under each desk accessory) 
Finder 3-17 
functions (see individual desk accessory listings) 

G 
Get file button (Scrapbook) 29 

H 
hard disk drives 7-8 
HyperDialer 38 

icons 5 
functions of 5 
collapsing of (see each desk accessory) 

installing 

K 

DeskWorks using a hard drive 
using the Finder 7-11 

DeskWorks using a one drive system 
using the Finder 11-16 

DeskWorks using a two 3.5-inch 7-16 
the entire DeskWorks folder 8, 13 
individual DeskWorks desk accessories 

12-13,14 
the Menu Clock 7-8 

Key clicks (Keymac) 40 
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keyboard 
macros (see Keymac) 
moving from field to field (see individual 

desk accessories) 
Keymacs 40-47 

application examples using 74-77 
Assign button 40, 41,42 
Cancel button 45,47 
Clear button 40, 43 
close box 40,31,47 
creating macros 41, 42, 46 
creating macro sets 43,47 
default settings 81 
deleting macros 43, 45 
disk capacity 81 
Edit button 40, 42 
Edit Keys check box 40,42 
editing macros 42 
exiting 47 
functions of 40 
keyboard equivalents 41 
Key field 40 
Label field 40 
location of 43, 44, 45 
Macro Definition field 40,41,42 
Macros On button 40 
modifier key 41 
naming sets 43,47 
New Folder button 45 
New button 40, 47 
Open button 40, 43, 45 
Remove button 40, 43 
sample application of 74, 77 
Save button 40,45, 46 
saving sets 45,47 

keyword 
and sequential 37 

L 
Label field (Keymac) 40,41 
labeling macros 40 

Last year button (Calendar) 24 
logarithms 56-57 

antilogarithms 56-57 

M 
macros (see Keymac) 
Macro Definition field 41, 42 
Macros On button 40 
Macro sets 43-47 
making backups 4-7 
mantissa 55-56 
Memory Expansion Card 4 
Memory keys 54-55 
Menu Clock 63 

default setting 81 
disk capacity 81 
location of 7-8, 12,83 

modifier key 40, 41 
Month button (Calendar) 24 
Mr. Apple 

default setting 81 
disk capacity 81 

Mr. Apple check box 61 
multiplication 53 

N 
natural antilogarithm 56-57 
natural logarithm 56-57 
New button 

PhoneFiler 35 
Keymacs 40 
Enigma 47 

Next Year button (Calendar) 24 
Noon field (Appointment Book) 25 
NotePad 23,50-52 

collapsing into icon 52 
default setting 81 
disk capacity 81 
with Edit commands 51-52 
exiting 52 
font style 51 
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functions of 50-51 
saving entries 38 
text capacity 50 
turning pages 51 
using NotePad 50-51 

OK button (Appointment Book) 25 
Open button 

Calendar 24 
Keymacs 40 
PhoneFiler 35 
Scrapbook 29, 30 

Opening desk accessories 
(see individual listings) 

p 

Parentheses Keys 54 
pause character (PhoneFiler) 38 
PhoneFiler 35-39 

Address field 35 
autodial function 38 
changing a record 37 
close box 35,39 
Clipboard operations 37 
closing PhoneFiler 38 
City and State field 35 
collapsing into an icon 38 
creating a record 36 
default setting 81 
deleting a record 37 
delimited 37 

dial cJD 35 
dialer 35 
disk capacity 80 
Edit Menu commands 37 
exiting phoneFiler 38-39 
field capacity 36 
functions of 35-36 
insertion of "I " 

keyword 36 
location of 83 

long distance dialing 38 
Miscellaneous field 35 
Name field 35 

New cJN 35 
opening PhoneFiler 35 
pause character 38 
Phone field 35 
record 36 
reducing to icon 39 
resizing PhoneFiler 
Reducing to icon 39 
Revert button 35 
Saving entries 36, 37 
Search button 35,36 
searching records using 

horizontal scroll bar 37 
sequential listings 37 
storing a record 36 
tab identifier 34 
tonal dialing 38 
with Edit commands 36-37 

placing scrap files in documents 31 

R 
RCL key (Calculator) 55 
Remove button (Keymacs) 40,43 
removing Desk Works desk accessories 
Revert button (PhoneFiler) 35 
Run 55 

S 
sample applications 67,77 
Save button (Keymac) 40,45,46 
saving 32 

macros and macro sets 45-47 
PhoneFiler records 36 
scrap files 31 

scientific notation (Calculator) 55-56 
scrap files 29-32 

16-17 
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Scrapbook 23, 29-34 
Cancel button 29 
creating scrap files 30 
Clipboard functions with scrapbook 31 
clipping a section of a scrap file 31 
close box 29 
Close button 34 
default setting 80 
deleting scrap files 33 
disk button 29 
disk capacity 33,81 
editing Scrapbook 34 
editing scrap files 
Get File button 29 
location of 84 
Open button 29,31 
opening a scrap file 
PICT files 32, 83 
restoring deleted files 37,38 
saving graphics 32 
scroll bars 29 
Select button 29,33 
using the Edit commands 31 
using Scrapbook 

Screen Saver 48-49 
activating 48 
default setting 81 
disk capacity 81 
exiting Screen Saver 49 
location of 82 
Screen Saver Active check box 48 
searching records (PhoneFiler) 34, 36-
37 
time settings 49 

scroll box 
Calendar 24 
Keymacs 40 
PhoneFiler 35 
Scrapbook 29 

Search button (PhoneFiler) 35 

sequential 37 
and keyword 37 

settings 
for Alarm Clock 61 
for Calendar/Appointment Book 24-
26 

Sine key 57 
"Special Files and Folders" 82, 83 
storage key (Calculator) 55 
storing PhoneFiler records 36 
subtraction 54 
System Clock 64 

default setting 81 
disk capacity 81 
location of 82 

System folder 7-14,16 
System Set.up folder 8, 11-12, 14, 16 
system utilities disk 
(see Apple II System Utilities Disk) 

viewing scrap files 29,33 
using scroll bars 29 

T 
tab identifier (PhoneFiler) 35 
Tangent key 57 
time 

Alarm Clock 62 
Menu Clock 63 
System Clock 64 

tonal dialing 38 
Trash Can icon 5, 16, 17 
trigonometric functions 57-60 
turning pages (NotePad) 51 
try box 65 

U 
uninitialized disk 5 
uses of 

3.5-inch disk drive 4,7-8, 12 
2 system drive 5,8-11,17 

Using DeskWorks with application in Finder 17 



StyleWare, Inc. . 
Technical Support: (713) 668-0759 

For Product Orders Only: (800) 233-4088 
(713) 668-074'3 
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